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(Note: Most of the contents of this whitepaper can also be found in the help files of the QuickBooks Conversion 
Tool.) 
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Converting Peachtree, SBA or Office Accounting files (overview) 

You can directly convert Peachtree 2001-2008, SBA or Office Accounting 2007 data files to QuickBooks 
company files. The conversion process copies your Peachtree, SBA or Office Accounting data to a new 
QuickBooks company, leaving your original data files unchanged. 

For older versions of Peachtree (prior to 2001), you must do a preliminary conversion into a compatible 
Peachtree version before you can convert the data to QuickBooks. For more information, call the 
QuickBooks Data Conversion Team at 800-816-9304. 

Before converting your company data to QuickBooks, make sure that you meet these QuickBooks 
requirements: 

• QuickBooks 2006, 2007 or 2008 must be installed on your computer. 
• QuickBooks must be registered/licensed. 
• QuickBooks must be updated to the latest release, or you must set Automatic update to OFF. (Go to the 

Help menu and click Update QuickBooks. Click the Options tab and make sure that Automatic Update 
is set to No.) 

• QuickBooks must be in single-user mode. (Go to the File menu and click Switch to Single-user Mode.) 

To ensure a smooth conversion of your company data, you first need to prepare the files for conversion. If your 
files are already prepared and ready for conversion, you can begin converting your data. 

After converting your data, you will have two sets of data: your original, unchanged company data file or folder 
and your new QuickBooks company file. 

Preparing Peachtree, SBA or Office Accounting files for conversion 

Before you convert your company data to QuickBooks, make a backup copy of your Peachtree, SBA or Office 
Accounting data file. 

To backup your Peachtree data folder: 

1. In Peachtree, go to the File menu and click Back Up. 
2. Check "Include Company in the Backup File Name." 
3. Select the backup location and save the file. 
4. Go to the File menu and click Data Verification to ensure that there are no problems with your file. 
5. (If required) Go to the Tasks menu, click System, and run the Year-End Wizard. 
6. (If required) Close and post any of your pending or open transactions. 

To backup your SBA or Office Accounting data file: 

1. In SBA or Office Accounting, go to the File menu and choose utilities, then choose Data Utilities. 
2. On the Basic Tools tab, choose Backup 
3. On the Backup window, choose Browse to choose the name and location of the backup file you are 

creating. 
4. If you wish to password protect your backup data, choose a password on the bottom of the Backup 

window. Be sure to write down this password and keep it in a safe location. 
5. Click OK. 



Then, to ensure an accurate conversion to QuickBooks, verify the following information and make changes in 
your original company data file, as necessary: 

• Decide whether to use names or IDs for customer, vendor, and employee records   

During the conversion process, you will be given a choice to use either the ID or the name for the 
QuickBooks customer, vendor, and employee names. Note that QuickBooks names must be unique and 
are limited to 41 characters. We recommend using the name value, since it is sometimes difficult to 
select the correct customer, vendor, or employee when using ID values. SBA and Office Accounting use 
names only, unless the user has chosen to use the ID field. 

• Remove any duplicate names   

You cannot use duplicate names in QuickBooks. To avoid any problems with customer, vendor, or 
employee conversions, you should edit the customer, vendor, and employee names in Peachtree, SBA or 
Office Accounting so that each one has a single, unique name. Also, compare and edit customer, vendor, 
and employee names on all other lists that include the names to ensure that all names are unique. Note 
that QuickBooks sees "Smith, Bob" and "Bob Smith" as the same name. If duplicate names are found 
during the conversion, QuickBooks will add a numeric suffix (001, 002) to differentiate between the two 
names. (After you convert your data, you can update and fine-tune your customer, vendor, and employee 
records in QuickBooks, if needed.)  

• Delete unneeded Peachtree, SBA or Office Accounting accounts   

Delete accounts that you know you won't want in QuickBooks. For example, you might want to delete 
any personal accounts not related to your business. 

Converting Peachtree, SBA or Office Accounting files (procedure) 

QuickBooks provides a simple tool to help you convert Peachtree, SBA or Office Accounting files to 
QuickBooks. Before you run the QuickBooks Conversion Tool, be sure to prepare your Peachtree, SBA or 
Office Accounting files for conversion. 

Turn off screen savers, disable any anti-virus software, and close all other applications, including memory 
managers. This will speed up the conversion process and avoid errors. 

To download and run the QuickBooks Conversion Tool: 

If you have already downloaded the QuickBooks Conversion Tool, you can skip to step 4. 

1. Go to the File menu, click Utilities, click Convert, and then click from Peachtree or from Microsoft 
Office Accounting. Or, you can point your Internet Explorer browser to: 

• http://accountant.intuit.com/convert (for accounting professionals) or 
• http://www.quickbooks.com/convert (for clients) 
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2. Complete the short form and click Submit. 

http://accountant.intuit.com/convert
http://www.quickbooks.com/convert
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3. Click Download. 
4. When the tool finishes downloading, you will be prompted to run the tool. You can launch the tool by 

double-clicking the desktop icon, selecting it inside the programs menu inside the Start button, or going 
to the folder where you installed the tool and double-clicking QBConversionTool.exe. 

5. Follow the onscreen instructions. 

Some converted fields will not be visible in QuickBooks if the feature is turned off. For example, you will not 
be able to access sales tax information if the Sales Tax preference is turned off. To review or change your 
QuickBooks preferences, start QuickBooks, go to the Edit menu, and click Preferences. Make changes as 
necessary. 

What Peachtree, SBA or Office Accounting data gets converted? 

The data conversion process will convert most of your Peachtree data to QuickBooks. However, some 
Peachtree, SBA or Office Accounting-specific information cannot be converted. 

To learn about what data will be converted (and not converted) for different areas, click on the appropriate link 
below to jump to a specific section. 

• Customer and Job lists 
• Vendor lists 
• Employee list 
• Transactions 
• Chart of Accounts 
• Item list 
• Support tables 

Customer-related data that gets converted to QuickBooks 

The QuickBooks Conversion Tool converts most of your customer and job data, with the following exceptions: 

• Default sales accounts associated with customers 
• Peachtree-specific fields (Supervisor, % Complete, PO Number, Estimated Expense, and Estimated 

Revenue) 

The following tables list the customer-related information that will be converted (or not converted). 

Customer data that gets converted to QuickBooks 
 
 

QuickBooks  
Field and Notes 

Peachtree  
Customer Address Information 

SBA / Office Accounting 
Customer Address Information 

Customer Name:  
Up to 41 characters. 

Customer Name or ID Customer Name 

Company Name:  Customer Name Customer Name 
Contact Contact Contacts: Primary Contact 
Phone Telephone 1 Contacts: Business Phone 
Fax Fax Business Fax 
Email E-mail Email 1 
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Bill To Bill To Address Bill To (if exists, otherwise 
Business address used) 

Ship To:  
Only one ship to address converted. 
Additional Ship-to addresses must 
be manually set up in QuickBooks 
as separate jobs under the customer 
name. 

Ship To Address 1 Ship to (if exists, otherwise 
Business address used) 

 
 

QuickBooks  
Field and Notes 

Peachtree  
Customer Additional Information 

SBA / Office Accounting 
Customer Additional Information 

Categorizing and Defaults: Type Customer Type Customer Group 
Categorizing and Defaults: Terms 
 
Note: QuickBooks, SBA and Office 
Accounting enable you to set up a 
list of terms. Peachtree supports a 
single set of "standard terms" as 
well as providing unique terms by 
customer. The QuickBooks Terms 
List is created from all the unique 
terms set within each Peachtree 
customer. Each customer will then 
reference the correct terms that 
were created in Peachtree. 

Terms and Credit Payment Terms 

Sales rep Rep Salesperson 
Not Converted:  

Note: Sales Tax items are converted 
to QuickBooks, but customer 
defaults are not assigned to the 
customer records. 

Sales Tax (Tax Item and Code) Tax Group 

Additional Info Tab: Custom Fields Custom Fields Tab: User-defined 
(Custom) fields 

Custom Fields Tab: User-defined 
(Custom) fields 

 
 

QuickBooks  
Field(s) and Notes 

Peachtree  
Payment Info 

SBA / Office Accounting  
Payment Info 

Credit Limit Credit Limit Credit Limit 
Not converted Preferred Payment Method Preferred Payment Method 
Name on Card 
Address 
Zipcode 
 
Credit card # not converted 

Credit Card Information N/A 
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QuickBooks  
Field and Notes 

Peachtree  
Job Info 

SBA / Office Accounting  
Job Info 

Job Status N/A Job Status 
Start Date Start Date Start Date 
End Date End Date End Date 
Job Description Description N/A 
Job Type Job Type Job Group 
 
 

Vendor-related data that gets converted to QuickBooks 

The QuickBooks Conversion Tool converts most of your vendor data, with the following exceptions: 

• Default sales accounts associated with vendors 
• Peachtree or SBA/Office Accounting-specific fields (Supervisor, % Complete, PO Number, Estimated 

Expense, and Estimated Revenue) 

The following tables list the vendor-related information that will be converted (or not converted). 

Vendor data that gets converted to QuickBooks 
 
 

QuickBooks  
Field and Notes 

Peachtree  
Vendor Address Information 

SBA / Office Accounting  
Vendor Address Information 

Vendor Name 
Up to 41 characters. 

Vendor Name: 
 

Vendor Name 

Company Name Vendor Name Vendor Name 
First Name, M.I., Last Name Contact. Vendor Name 
Name and address Address 

City, ST Zip 
Country 

Addresses: Business Address 

Contact Name Contact Primary Contact 
Phone number Telephone 1 Business Phone 
Fax number Fax Business Fax 
Alternate Phone number Telephone 2 Other Phone 
E-mail address Email Email1 
Print on Check as Vendor Name Vendor Name 
 
 

QuickBooks  
Field and Notes 

Peachtree  
Vendor Additional Information 

SBA / Office Accounting  
Vendor Additional Information 

Account No. Vendor ID Uses Peachtree's "Our Account 
With Them" 

Type Vendor Group Peachtree Vendor Type 
QuickBooks enables you to set up a 
list of terms. Peachtree supports a 
single set of "standard terms" as 

Payment Terms Terms and Credit 
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well as providing unique terms by 
vendor. The QuickBooks Terms 
List is created from all the unique 
terms set within each vendor. Each 
vendor will then reference the 
correct terms that were created in 
Peachtree. 
Credit Limit Credit Limit Credit Limit 
Tax ID Federal Tax ID Tax ID # 
Vendor eligible for 1099 Vendor 1099 1099 Type 
Additional Info Tab: Custom Fields Custom Fields Tab: User-defined 

(Custom) fields 
Custom Fields Tab: User-defined 
(Custom) fields 

 
 

Employee-related data that gets converted to QuickBooks 

The QuickBooks Conversion Tool converts most of your employee data, with the following exceptions: 

• Peachtree-specific fields (Position, Birthday, Spouse, Emergency contacts) 

The following tables list the employee-related information that will be converted (or not converted). 

Employee data that gets converted to QuickBooks 
 

QuickBooks  
Field and Notes 

SBA / Office Accounting 
Employee Personal Information 

Peachtree  
Employee Personal Information 

First, Middle and Last Name 
(up to 41 characters) 

Employee Name First, Middle, and Last Name  

Print on Checks As File as Same as the Peachtree Employee 
Name. 

SS No. N/A Social Security # 
Gender Gender N/A 
Date of Birth Date of Birth N/A 
 
 

QuickBooks  
Field and Notes 

SBA / Office Accounting 
Employee Contact Information 

Peachtree  
Employee Contact Information 

Address, City, State, Zip Street, City, State, Zip Same as Peachtree. 
Phone Home Telephone 1 
Cellular N/A N/A 
Alt. Phone N/A N/A 
FaxD Home fax N/A 
E-mail Email 1 Email 
Pager N/A N/A 
PIN (Pager) N/A N/A 
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QuickBooks  
Field and Notes 

SBA / Office Accounting 
Employee Additional 

Information 

Peachtree  
Employee Additional 

Information 
Account No. N/A Employee ID 
Billing Rate Level  Not converted. 
Define (Custom) fields Custom Fields Custom Fields 
 
 

QuickBooks  
Field and Notes 

SBA / Office Accounting 
Employee Payroll and 

Compensation Information 

Peachtree  
Employee Payroll and 

Compensation Information 
Paychecks or employees YTD 
information are not converted. You 
must make a manual YTD 
Adjustment for each employee that 
summarizes each employees YTD 
Payroll information. Or, you can 
recreate all the employees 
paychecks, but this might be a time 
consuming effort. The YTD 
information will be sufficient for 
year-end W2's and YTD 
information on future paychecks. 

  

Employee Payroll Setup 
Information 

These fields are not converted 
(Sick Pay, Vacation, DD Info, 
Payrates, Taxes, Withholdings, 
Deductions). 

These fields are not converted 
(Sick Pay, Vacation, DD Info, 
Payrates, Taxes, Withholdings, 
Deductions). 

 
 

QuickBooks  
Field and Notes 

SBA / Office Accounting 
Employment Information 

Peachtree  
Employment Information 

Employment Dates  Hire and Release Dates will be 
converted from Peachtree. 

Employment Details (Type)  These employment fields (Regular, 
Officer, Statutory, Owner) need to 
be manually entered. 

 

Transaction data that gets converted to QuickBooks 

The QuickBooks Conversion Tool converts all historical transactions from Peachtree, SBA or Office 
Accounting. Transactions will include all line item detail.  

The following sections list the information that will be converted (or not converted) for transactions. 

Transaction types 
 

• Invoices 
• Credit Memos 



 
10    Intuit Inc. 

• Customer Payments 
• Sales Receipts 
• Deposits 
• Bills 
• Vendor Credits 
• Vendor Payments 
• Checks 
• Credit Card Charges 
• Credit Card Credits 
• Purchase Orders 
• Estimates 
• Sales Orders 
• Journal Entries 
• Inventory Adjustments 
• Item Receipts 
• Assembly Builds 

 

If necessary, QuickBooks will also make an adjustment: 

• Beginning Balance Entry: Peachtree allows the user to view only the historical data for the current and 
prior fiscal year. All transactional history recorded prior to this is summarized into beginning balances. 
The QuickBooks Conversion Tool is able to read all historical data, including transactions prior to these 
beginning balances. In the case that the beginning balances created by Peachtree do not match the total 
of all prior transactions up to the beginning balance date, the conversion tool will create a beginning 
balance entry to ensure that the QuickBooks GL balances match the Peachtree balances as of the 
beginning balance date. 

Invoices and credit memos 

For all invoices and credit memos, the following information is converted:

• Customer Name:Job 
• Invoice date 
• Invoice number 
• Line item details 
• Sales Tax 
• Classes 
• Customer's Bill to Address 
• Terms 
• Ship to Date 
• Memo 
• Payment History 

Custom invoice or credit memo form templates are not converted to QuickBooks 
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Bills and bill credits 

For all bills and bill credits, the following information is converted:

• Vendor Name 
• Original Bill date 
• Bill number 
• Line Item Details 
• Classes 
• Bill to date 
• Job Costing 
• Terms 
• Reference Number 
• Payment History 

Custom bill or bill credit form templates are not converted to QuickBooks 

Chart of Accounts data that gets converted to QuickBooks 

There are two types of accounts: 

• Real-world accounts (such as a checking or savings account) 
• Income and expense accounts (synonymous with categories in Quicken) 

In QuickBooks, the list of all these accounts is called the chart of accounts. The chart of accounts defines the 
accounts in your general ledger and categorizes them into assets, liabilities, equity, income, and expense 
accounts. The way your chart of accounts is set up determines how your profit and loss and balance sheet 
reports look and what information they contain. 

Before converting to QuickBooks, you should review your chart of accounts in Peachtree, SBA or Office 
Accounting and modify it to match your specific business needs, if necessary. For example, you might need to 
rename or add bank accounts, assets, loans, or equity accounts. Also you might want to delete accounts that you 
do not plan to use in QuickBooks. 

Before you customize the chart of accounts, make a backup of your Peachtree, SBA or Office Accounting file, 
print the chart of accounts, and then determine the accounts you want to add, edit, or delete. Some of your 
accounts might have been created automatically and might not be able to be deleted. Before making changes to 
their chart of accounts, clients might want to consult their accountant. 

The QuickBooks Conversion Tool converts most of your account-related data, except when the information is 
unique to Peachtree, SBA or Office Accounting. 

The following tables list the chart of accounts data that will be converted (or not converted). 

Account data that gets converted to QuickBooks 
 

QuickBooks  
Account Type 

Peachtree  
Account Type 

SBA / Office Accounting  
Account Type 

Bank Cash Cash/Bank 
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Accounts Receivable Accounts Receivable Accounts Receivable 
Other Current Asset Other Current Assets/Inventory Other Current Asset/Inventory 

Asset 
Fixed Asset Fixed Asset/Accumulated 

Depreciation 
Fixed Asset 

Other Asset Other assets Other Asset 
Accounts Payable Accounts Payable Accounts Payable 
Credit Card Not available in Peachtree. Credit Card/Line of Credit 
Other Current Liability Other current liabilities Current Liability/Payroll Liability 
Long Term Liability Long term liabilities Long Term Liability 
Equity All Equity Accounts Equity 
Income Income Income 
Cost of Goods Sold Cost of Sales Cost of Goods Sold 
Expenses Expenses Expenses 
Other Income Not available in Peachtree. Other Income 
Other Expenses Not available in Peachtree. Other Expenses 
 
 

QuickBooks  
Account Fields 

Peachtree  
Account Fields 

SBA / Office Accounting  
Account Fields 

Chart of Account Number 
(If you want to use account 
numbers in your chart of accounts, 
you can set up QuickBooks so that 
your chart of accounts shows an 
account number next to each 
account name.) 

For example: 

• 2000 Accounts Payable 
• 2100 Payroll Liabilities 
• 2200 Sales Tax Payable 

Refer to the QuickBooks in-product 
Help for instructions on how to 
assign account numbers to an 
account. 

Account Number Peachtree Account ID  

 

Name 
(QuickBooks will automatically 
use the Account Name/Description 
for the QuickBooks Account name, 
up to 31 characters.) 

Account Name Account Description in Peachtree. 

 

GL ACCOUNTS CREATED DURING CONVERSION 
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During conversion QuickBooks may encounter transactions that require special accounts to be created. ALL 
created accounts have an * behind the account name. These accounts will need to be researched to see the 
different account posting requirements between Peachtree and QuickBooks.  

Below are some general examples of why these accounts may be created:  

 
Bad Debt Expense-B* (TYPE=Bank)  

• A check, deposit, or payment from Peachtree not posting to a "Bank" type account as the source 
(QuickBooks requires these type transactions to post to a Bank type account). In this example, a check 
or deposit was posting to an Expense account called Bad Debt (Report results: QuickBooks P&L 
expense increased and QuickBooks Balance Sheet decreased)  

Other Income-AR* (TYPE = Accounts Receivable)  

• An Invoice or customer payment not posting to an Accounts Receivable type account as the source 
(QuickBooks requires these type transactions to post to an AR type account). In this example, an Invoice 
or payment was posting to an account named Other Income (income type account) and not to the AR 
side. (Report results: QuickBooks P&L Income decreased and QuickBooks Balance Sheet increased)  

Accounts Receivable-A* (TYPE=Other Current Asset)  

• Invoice, Customer Payment, Credit Memo, (Peachtree checks & Sales receipts going to an AP account) 
(Peachtree Invoices going to an AR account twice) (Report results: QuickBooks since it is basically 
moving these from AR to Other Current Asset = No affect on Balance Sheet)  

Property Tax Payable-AP* (TYPE=Accounts Payable)  

• An Bill or bill (vendor) payment not posting to an Accounts Payable type account as the source 
(QuickBooks requires these type transactions to post to an AP type account). In this example, a Bill or 
Bill payment was posting to an account named Property Tax Payable and not to the AP side. (Report 
results (Peachtree vs. Quickbooks): Quickbooks P&L and Balance Sheet as long as a similar Balance 
Sheet account = no affect (if move from P&L to Balance Sheet=changes)  

Accounts Payable-L* (TYPE=Other Current Liability)  

• Bill, Bill Payment, Bill Credit, (check or Sales receipt going to an AP account) (bill or payment going to 
an AP account twice) (Report results (Peachtree vs. QuickBooks): QuickBooks since it is basically 
moving these from AP to Other current Liability = No affect on Balance Sheet)  

Item-related data that gets converted to QuickBooks 

In QuickBooks, an item is anything that your company buys, sells, or resells in the course of business, such as 
products, labor, shipping and handling charges, discounts, and sales tax (if applicable). 

Items help you fill out the line item area of sales or purchase forms quickly. When you choose an item from 
your Item list, QuickBooks fills in a description of the line item and calculates its amount for you. 
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QuickBooks provides twelve different types of items. Some (such as the service items or the inventory part 
items) help you record the services and products your business sells. Others (such as the subtotal item or 
discount item) are used to perform calculations on the amounts in a sale. 

For more information about creating or editing items in QuickBooks, refer to the QuickBooks in-product Help. 

The QuickBooks Conversion Tool converts most of your item information, except when the information is 
unique to Peachtree. 

The following tables list the item-related information that will be converted (or not converted). 

 

Item data that gets converted to QuickBooks 
 

QuickBooks  
Item Type 

Peachtree  
Item Class 

SBA / Office Accounting 
Item Type 

Definition and Notes 

Service Labor, Service, or 
Activity Item 

Service Services you charge for or 
purchase. Examples 
include specialized labor, 
consulting hours, and 
professional fees. 

Inventory Part Stock Item Inventory Goods you purchase, 
track as inventory, and 
resell. 

Inventory Assembly Assembly Item N/A (QuickBooks Premier and 
Enterprise Solutions only) 
Assembled goods you 
build or purchase, track as 
inventory, and resell. 
Note: QuickBooks cannot 
track the costs associated 
with the manufacturing 
process itself. In other 
words, the cost of a built 
assembly item depends 
only on the cost of its 
components. 

Non-inventory Part Non-stock Non-Inventory Item Goods you buy but don't 
track (such as office 
supplies), or materials 
you buy for a specific job 
that you charge back to 
your customer. 

Fixed Asset Not converted. Not part of the Item List An asset you do not 
expect to convert to cash 
during one year of normal 
operations. A fixed asset 
is usually something that 
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is necessary for the 
operation of your 
business, such as a truck, 
cash register, or 
computer. 

Other Charge Charge Item N/A Miscellaneous labor, 
material, or part charges 
such as delivery charges, 
setup fees, and service 
charges. 

Subtotal N/A N/A Totals all items above it 
on a form, up to the last 
subtotal. Useful for 
applying a percentage 
discount or surcharge to 
many items. 

Group N/A Kit Item A way of associating 
individual items that often 
appear together on 
invoices, purchase orders, 
and so on, so that all 
items in the group can be 
added to the form at one 
time. 

Discount N/A N/A Subtracts a percentage or 
fixed amount from a total 
or subtotal. Do not use 
this item type for an early 
payment discount. 

Payment N/A N/A Records a partial payment 
you received at the time 
of the sale. It reduces the 
amount owed on an 
invoice. 

Sales Tax Item Sales Tax Authority Tax Code Calculates a single sales 
tax at a specific rate that 
you pay to a single tax 
agency. For Peachtree 
conversions Each 
QuickBooks tax item 
(whether exempt or not) 
is converted to from a 
sales tax authority, a 
component of Peachtree's 
sales tax codes. Each non-
exempt tax item is also 
converted as its own 
QuickBooks sales tax 
code. 
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Sales Tax Group Sales Tax Code Tax Group Each Peachtree sales tax 
code is converted to a 
QuickBooks sales tax 
group, containing their 
respective tax item 
components. Calculates 
and individually tracks 
two or more sales tax 
items that apply to the 
same sale. The customer 
sees only the total sales 
tax. 

 

Item Name/Number 
 

QuickBooks Peachtree SBA / Office Accounting Notes 
Item Name/Number Item ID Item Name Item names are limited to 

31 characters. If you want 
to group items, you can 
create subitems. For 
example, you can create 
an item called "Socks" 
and subitems for "Black" 
and "Blue". 

 

Item Purchase Information 
 

QuickBooks Peachtree SBA / Office Accounting Notes 
Description on Purchase 
Transactions 

Purchase Description Purchase Description Behaves the same. 

Cost Cost from Bills Purchase Price Behaves the same. 
COGS Account GL Cost of Sales Account Expense Account Behaves the same. 
Preferred Vendor Vendor Name Preferred Vendor Behaves the same. 
 

Item Sales Information 
 

QuickBooks Peachtree SBA / Office Accounting Notes 
Description on Sales 
Transactions 

Sales or Item Description Sales Description Behaves the same. 

Sales Price Price Level 1 Amount Sales Price Behaves the same. 
Tax Code NA Item Tax Behaves the same. 
Income Account GL Sales Account Income Account Behaves the same. 
 

Price Levels 
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QuickBooks Peachtree Notes 
Item Name Item ID Behaves the same. 
Custom Price Price Level Amount Behaves the same. 
Item Type Item Type Behaves the same. 
 

If a percent is entered in Peachtree, it calculates the dollar value and Peachtree uses the dollar amount. Since 
Peachtree does not use a percent method, only the dollar value will be transferred to QuickBooks. If you want to 
enter the price level in percent terms after conversion, you can manually enter this percent into QuickBooks. 

SBA and Office Accounting do not directly link items to price levels. A price level is a percentage that 
increases or decreases the total amount of an entire transaction. 

Inventory Information 
 

QuickBooks Peachtree SBA / Office Accounting Notes 
Asset Account GL Asset Account Asset Accounting Behaves the same. 
Reorder Point Reorder Quantity Reorder Point Behaves the same. 
On Hand QTY on Hand On Hand Behaves the same. 
Average Cost Cost Method FIFO QuickBooks uses 

PERPETUAL (Average 
Cost) Inventory. 

For an inventory item, 
average cost is the total 
cost of the items currently 
in stock divided by the 
number of items in stock. 
QuickBooks uses average 
cost (and not another 
method such as LIFO or 
FIFO) to determine the 
value of your inventory. 

QuickBooks recalculates 
the average cost of an 
item every time you 
record the purchase of 
more units of the item. It 
adds the cost of the new 
items to the cost of the 
old stock and then divides 
by the total number of 
new and old items. 

If in Peachtree you 
tracked inventory using 
FIFO or LIFO then these 
values are converted to an 
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Average Cost in 
QuickBooks. 

Clients might want to talk 
to their accountant (or 
notify the IRS) if there 
are changes in the way 
they are reporting 
inventory (FIFO, LIFO vs 
Average Cost). 

On P.O. N/A N/A  
On Sales Order N/A N/A  
Define (Custom) fields Custom Fields User Defined Fields Behaves the same 
 

For items with no accounts during conversion, QuickBooks creates these accounts: 

• MissingInvAsset: created if there is not an inventory asset account associated with an Inventory Item. 
When populated, this is the total current inventory cost (inventory adjustment). 

• MissingInvSales: created if there is not an income account associated with an Inventory Item. 
• MissingInvCOGS: created if there is not a COGS account associated with an Inventory Item. 

Support tables that get converted 

To support the accurate conversion of your customer and vendor lists, QuickBooks converts basic information 
from these support tables: 

• Price Level (QuickBooks converts ten sales pricing levels from Peachtree) 
• Sales Tax Code 
• Class 
• Sales Rep 
• Customer Type 
• Vendor Type 
• Job Type (QuickBooks converts the job type referenced in Peachtree jobs to the QuickBooks Job Type 

List) 
• Terms 
• Customer Message 
• Payment Method 
• Ship Via (QuickBooks cannot convert the Ship Via list, since they are set up in Peachtree's Inventory 

defaults. However, you can set up each customer or vendor record to use a default ship-via method, or 
you can select a ship-via method on a case-by-case basis.) 

For more information about any of support tables, refer to the QuickBooks in-product Help. 

Differences between Peachtree, SBA / Office Accounting and QuickBooks 

There are some important differences between the programs that you should be aware of as you begin using 
QuickBooks. For a more thorough description of any of the information below, refer to the QuickBooks in-
product Help. 



Names and addresses  

Addresses (for companies, customers, vendors, and employees) are entered differently in Peachtree than they 
are in QuickBooks or SBA/Office Accounting. In QuickBooks, you enter addresses in a free-form, four-line 
field. In Peachtree, you must enter each part of the address in its own field. The QuickBooks method enables 
you to enter the address in any format you want. 

To ensure that the addresses you have entered in Peachtree or SBA/Office Accounting appear the way you want 
them to appear in QuickBooks, make sure the addresses entered adhere to the U.S. Postal Service standard 
format. If necessary, you can edit these addresses after the conversion. 

Billing and shipping addresses  

In QuickBooks, you can have one billing address and unlimited shipping addresses per customer. Peachtree 
limits you to nine shipping addresses per customer. In SBA/Office accounting there is one address for Bill to, 
Ship to, Legal, Warehouse, Home, Postal, and Other. 

Customer jobs  

Job costing is a way to track the expenses for a job and then to compare those expenses to the job's revenue. 
This comparison tells you which jobs make money and which do not. 

In QuickBooks, jobs are associated with individual customers and are managed via the Customers & Jobs list. 
In Peachtree, jobs are managed in their own list. 

Charging and paying sales tax  

If you are required to collect sales tax for the products or services you sell, you must pay it to a tax agency on a 
regular schedule. You must follow the rules and regulations for collecting and paying sales tax in your tax 
district (city, county, state). 

In QuickBooks, sales tax items are used to track the sales tax rates and the tax agencies you pay. QuickBooks 
uses sales tax codes to track the taxable status of your customers and the products and services you sell.  

In Peachtree, the sales tax rates are set up as sales tax codes. Each sales tax code is made up of at least one sales 
tax authority. All sales tax districts in Peachtree (whether exempt or not) are converted as sales tax items. 
During the conversion to QuickBooks, all Peachtree sales tax codes are converted to sales tax group items. 
Sales tax group items can contain one or more sales tax items (Peachtree tax authorities). 

In SBA/Office Accounting, the individual sales tax rates are setup as sales tax codes. Each code contains only 
one rate. These rates can be grouped together as a Tax Group, and these Tax Groups can be used on 
transactions. 

Setting up sales tax items involves these general steps: 

1. Set up your tax agencies (to whom you pay your collected sales taxes) as vendors in the vendor list. 
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2. Set up individual sales tax items. These items are the components of the sales tax group items. For 
example, you can have a state tax and a county tax that are combined to create a sales tax group item. 

Setting up sales tax for customers  

Each customer must be assigned a default sales tax item and sales tax code in QuickBooks. QuickBooks will 
select the sales tax item that matches the tax code listed in the Peachtree customer record. You will need to 
assign a tax code to each customer.  

Peachtree requires each customer to have a default sales account (typically an income account). QuickBooks 
does not assign sales accounts for customers. 

 

What to do in QuickBooks after the conversion 

 
First, enter company information in your QuickBooks file. 
Company information is not imported and must be manually entered into QuickBooks.  

1) Open QuickBooks, select Company, and then Company Information.  
2) In Peachtree, select Maintain, and then Company information.  
3) In Small Business Accounting\Office Accounting, select Company, and then Company information 
4) Copy and paste all company information from Peachtree\Microsoft to QuickBooks.  

 
Next, set up the preferences. 
Some converted fields in QuickBooks will not be visible till the preferences are edited in QuickBooks.  
 

• In QuickBooks, go to the Edit Menu and select “Preferences”.  Most preferences are found on the 
“Company Preferences” tab. 

• Please review and set up preferences as needed, particularly:  
o Payroll & Employees: Turn on Full Payroll if you create paychecks  
o Reports: Check the reports preference for Accrual or Cash Basis reporting (change as needed)  

 
Finally, verify the conversion data by: 

1) Comparing the list items in QuickBooks to those in Peachtree. 
In Peachtree go to Help, Customer Support, then Service and File Statistics. In QuickBooks hit the F2 
key. This brings up the Product Information screen. In the lower right corner will be the List 
Information. Compare the following (There is no statistics screen for Microsoft to verify numbers):  
 

a. In QuickBooks, see the number of Total Accounts. In Peachtree, see Chart. The number of 
records in Peachtree will be lower from 3 to 8 accounts, due to accounts that QuickBooks uses to 
do the conversion. 

b. In QuickBooks, see Customers. In Peachtree, see Customer. QuickBooks should have one extra 
customer. This extra customer exists for transactions in Peachtree that do not have a customer 
name linked to it. There may be jobs in Peachtree or SBA/Office Accounting that were assigned 
to Customers. In QuickBooks these will show on the Customer:job list under the Customer 
name. 
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c. In QuickBooks, see Vendors. In Peachtree, scroll down to see Vendor. The number in 
QuickBooks may be larger by 1, due to QuickBooks creating a vendor called Sales Tax Vendor. 
May also be different if there were duplicate Vendor names in Peachtree.  

d. In QuickBooks, see Employees. In Peachtree, see Employee. These should match unless there 
were duplicate Employee names in Peachtree.  

e. In QuickBooks, see Total Items. In Peachtree see Line Item. This will be the Inventory and other 
items that were imported. These should match, but the number in QuickBooks will also include 
Sales Tax items that were created from the Sales Tax Codes in Peachtree.  

f. In QuickBooks, you may see a number in Other Names. Names on this list do not match any 
Customer or Vendor from Peachtree. Go to Lists, Other Names List to see these names. They are 
names that were used in transaction, such as checks, but are not on the Customer:job list or the 
Vendor list.  

 
2) Comparing QuickBooks reports to Peachtree or SBA\Office Accounting reports. 

Compare the following reports in both Peachtree or SBA\Office Accounting and QuickBooks as of the 
accounting period date you chose when using the Conversion Tool.  
 

a. Balance Sheet in both. In QuickBooks and in SBA\Office Accounting, this report and the Profit 
and Loss report are found under the Reports, Company & Financial menu.  

b. Income Statement in Peachtree and Profit and Loss in QuickBooks. See above.  
c. General Ledger Trial Balance in Peachtree and Trial Balance in SBA\Office Accounting and 

QuickBooks. In QuickBooks this will be found under Reports, Accountant and Taxes, Trial 
Balance. In SBA\Office Accounting, this will be found in Reports, Company and Financial, Trial 
Balance. 

d. If you had open invoices in Peachtree, run the Aged Receivables report. This will show the open 
A/R in Peachtree. In QuickBooks or in SBA\Office Accounting go to Reports, Customers & 
Receivables, A/R Aging Summary report. This will show the open balances for each customer. 
Total balance should match the Total balance showing in Peachtree or SBA\Office Accounting. 
Individual customer balances should also match. To see the detail for each customer in 
QuickBooks, double-click on the Total amount for the name.  

e. If you had open bills in Peachtree, run the Aged Payables report. This will show the open A/P in 
Peachtree. In QuickBooks or in SBA\Office Accounting go to Reports, Vendors & Payables, A/P 
Aging Summary report. This will show the open balances for each vendor. Total balance should 
match the Total balance showing in Peachtree or SBA\Office Accounting. Individual vendor 
balances should also match. To see the detail for each Vendor in QuickBooks, double-click the 
Total amount for the name.  

 
3) Verify list information. 

a. Look at the Chart of Accounts to see that the accounts in QuickBooks match the accounts you 
had in Peachtree or SBA\Office Accounting.  

b. On the Home page, click on Customers. You will see a list of Customers and Jobs and their open 
balances. The default will show Active Customers. You can also choose to see All Customers, 
including inactive customers, and Customers with Open Balances. To edit a Customer, click on 
the name and then click on Edit Customer.   

c. On the Home page, click on Vendors. You will see a list of Vendors and their open balances. 
The default will show Active Vendors. You can also choose to see All Vendors, including 
inactive Vendors, and Vendors with Open Balances. On the Vendor list you may see names that 
have a V- in front of the name. These indicate that they are duplicate names, the name may also 
be on the Customer:job list. QuickBooks does not allow duplicate names. They will have the 
correct name in a field called Print on Check As and this allows the checks to print without 



 
22    Intuit Inc. 

having the V- in front of the name. To edit a Vendor, click on the vendor name and then click on 
Edit Vendor.  

d.  On the Home Page, click on Employees. You will se a list of Employees with their Social 
Security Numbers, if these were in Peachtree. The default will show Active Employees. You can 
also choose to see All Employees, which will include inactive employees, and Released 
Employees. To edit an Employee click on the name and then click on Edit Employee.  
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